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Sari

Ada tiga komponen dalam naskah, yaitu teks (tipografi), gambar, persamaan matematika. Gambar dibagi menjadi dua
macam, yaitu raster dan vektor. Komponen-komponen ini sering dianggap sepele oleh sebagian besar penulis, padahal hasil
cetak sangat tergantung kepada komponen ini. Misalnya, pernah kah anda membaca sebuah buku atau artikel yang gam-
barnya tidak jelas, jenis hurufnya tidak enak dibaca, dan pengaturan paragrafnya kacau? KTgX dengan front-end LyX
bisa digunakan untuk me-layout naskah publikasi ilmiah yang konsisten dan padat. ITEX cukup sulit digunakan untuk
kalangan pemula yang biasa menggunakan perangkat lunak word processor seperti Word, OpenOffice.org Writer, dll. LyX
dengan tampilan mirip pengolah kata dapat dipelajari dengan mudah tanpa atau dengan sedikit pengetahuan ETEX. Untuk
menambahkan gambar atau bagan alir, dapat menggunakan perangkat lunak yang lain, seperti GIMP, Inkscape, OpenOf-
fice.org, dan Gnuplot. Sedangkan untuk menambahkan bibliografi bisa mengQunakan perangkat lunak seperti JabRef, py-
bliographer, bibdesk, atau diketik dengan text-editor dengan format bibTEX. Syle pada Ringkasan ini menggunakan paket
abstract (lihat Wilson et al. (2009)).
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Abstract

There are three componen in a document, i.e., text (tipography), figure, mathematical equation. Figure can be devided
into two groups, i.e., raster and vector. These components seem to be unimportant by most of author in Indonesia, however
the printing result is depended on these components. For example, have you read a book or an article with a blur figures, bad
font, and unusual paragraph setting? KTEX with LyX front-end can be used to layout document consistently and compact.
WTEX is difficult for common user which normally use word processor, such as Word, OpenOffice.org Writer, etc. LyX with
GUI look like a common word processor dan be learned easily without or less knowledge of KTgX. To combine with figure or
diagrams, we can use some OpenSource softwares, like GIMP, Inkscape, OpenOffice.org, and Gnuplot; where as to combine
with bibliography, we can use softwares like JabRef, pybliographer, bibdesk, or type manualy by using text-editor with a

bibTEX format.

Keywords: publication, document processing, TEX, LyX, bibTgX.

1 Pendahuluan

Pada dekade terakhir ini telah dikenal cukup banyak
perangkat lunak bantu untuk menulis naskah, dari
yang sangat sederhana (berbasis text), seperti Chi-
Writer, WordStar 4-7, Lotus Manuscript; hingga yang
canggih (berbasis GUI), seperti WordStar for Win-
dows, WordPerfect, Lotus WordPro, StarWriter, Mi-
crosoftWord, dll. Semua perangkat lunak terse-
but hanya dapat dijalankan pada sistem operasi
DOS/MSDOS dan Microsoft Windows®.

Di lingkungan sistem operasi Linux (dan varian-
nya, seperti Unix, Solaris, dan BSD) juga dikenal
beberapa perangkat lunak OpenSource untuk keper-
luan semacam ini, seperti KWord, AbiWord, Star-
Office Writer, Applixware, OpenOffice.org Writer,

*Isinya bisa macam-macam, misalnya alamat saya: Department
of Geological Engineering, Faculty of Engineering, Gadjah Mada
University. JI. Grafika No. 2 — Bulaksumur, Yogyakarta 55281. E-
mail: warmada@gmail.com (kalau mau ngirim2 kado...;-)).

GNU/TEXMACS, IXIEX, LyX, groff, lout, dll. Namun
di antara perangkat lunak ini yang menarik adalah
LyX. LyX merupakan suatu perangkat lunak peng-
olah naskah yang berbasis grafis (GUI), merupakan
front-end dari IATEX2¢. Sekarang ini, hampir semua
perangkat lunak OpenSource sudah di-port ke dalam
bermacam-macam sistem operasi, seperti Microsoft-
Windows, MacOS X.

2 Publishing

Ada empat komponen dalam naskah, yaitu teks
(tipografi), gambar, tabel, persamaan matematika.
Gambar dibagi menjadi dua macam, yaitu raster dan
vektor. Komponen-komponen ini sering dianggap
sepele oleh sebagian besar penulis, padahal hasil
cetak sangat tergantung kepada komponen ini. Mis-
alnya, pernah anda membaca sebuah buku atau ar-
tikel yang gambarnya tidak jelas, jenis hurufnya tidak
enak dibaca, dan pengaturan paragrafnya kacau?
Ada cukup banyak referensi tentang bagaimana
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Figure 1: Banner LyX versi 2.x.x

membuat publikasi yang bagus, seperti Khazaeli
(2001); Kipplan (2001) dan buku-buku tentang ti-
pografi, seperti Sihombing (2001); Strizver (2006);
Syropoulos et al. (2003). Pada Tabel 1 adalah
perangkat lunak berbasis FOSS yang bisa digunakan
untuk membuat publikasi naskah ilmiah. Penulis
sendiri menyelesaikan disertasi tanpa menggunakan
perangkat lunak komersial (Microsoft befreien PC = PC
bebas Mikrosoft, diambil dari headline majalah di Jer-
man beberapa tahun silam...:)). Jadi, gak perlu beli
apalagi membajak, hehe.

3 Apaitu LyX?

LyX (Gambar 1) merupakan suatu sistem preparasi
naskah yang pada awalnya diciptakan oleh Matthias
Ettrich. LyX dapat membuat suatu artikel teknik atau
ilmiah yang kompleks dengan matematik, acuan-
silang, bibliografi, indeks, dll. Selain itu, IyX juga
dapat digunakan untuk beberapa bentuk penulisan,
seperti memo, surat, disertasi dan tesis, catatan ku-
liah, catatan seminar, prosiding konferensi, doku-
mentasi perangkat lunak, buku (tentang PostgreSQL,
penginderaan jauh, kriptologi, cerita fiksi, puisi dan
juga buku-buku untuk anak), artikel yang disitir un-
tuk jurnal, skrip untuk film, proposal bisnis, dll.

LyX adalah suatu program yang menyediakan su-
atu pendekatan modern pada penulisan naskah den-
gan komputer . Tidak seperti sebagian besar pen-
golah kata yang menggunakan paradigma “konsep
mesin ketik”, LyX menggunakan paradigma "markup
language’ sebagai inti gaya penyuntingan. Hal itu be-
rarti jika kita akan menulis judul subbab, kita tandai
sebagai “Section”, bukan “Bold, 17 pt, rata kiri, dan
5 mm spasi di bawahnya”. Jadi dengan LyX, penulis
dapat berkonsentrasi pada isi yang akan ditulis. Con-
toh pemakaian LyX untuk menulis karya ilmiah pop-
uler bisa dibaca pada Warmada (2003b,a, 2004); dan
Warmada (2011).

Pada umumnya program pengolah kata selalu
membanggakan dirinya dengan moto WYSIWYG
(What you see is what you get), meskipun tidak tepat
100%, kecuali pada GNU/TEXMACS. LyX di sisi lain,
memakai moto WYSIWYM (What you see is what you
mean), yang berarti bahwa apa yang ditulis di la-

yar monitor, merupakan naskah yang akan terfor-
mat seperti yang diinginkan. Sehingga apa yang di-
tulis pada daerah penyuntingan LyX hasilnya tidak
sama persis dengan apa yang dicetak atau yang dita-
mpilkan dengan ghostview atau Acrobat Reader.

Sebagai pengolah naskah, LyX mempunyai beber-
apa keunggulan, seperti:

o Konsistensi tampilan, dimana tidak terjadi pe-
rubahan jenis atau ukuran huruf tanpa disen-
gaja. Tampilan dikendalikan oleh “style” yang
dipilih.

e Penomoran otomatis, seperti pada nomor gam-
bar, tabel, catatankaki, daftar, bab-subbab.

o Referensi silang. Referensi silang antar bagian,
misalnya seperti pada penulisan “lihat Gambar
1.17. LyX dapat menentukan referensi silang
yang tepat, karena semua jenis penomoran
diatur oleh LyX.

e Bibliografi dapat dimasukkan secara otomatis
dari database BibTgX. Dengan cara ini tidak akan
ada kesalahan penulisan bibliografi karena kelu-
paan atau kelebihan bibliografi.

e Susunan tata-letak (layout) yang padat.

o Gratis, bersifat Open Source (FOSS): source pro-
gram (dalam bahasa C++ dan Python) bisa di-
modifikasi dan dikompilasi sesuai keinginan.

LyX adalah salah satu front-end I£TEX yang berba-
sis GUI, yang dapat dijalankan pada hampir semua
platform sistem operasi. I£IEX sudah cukup lama
dikenal sebagai alat untuk menata tata letak (layout)
buku atau majalah yang berkaitan dengan ilmu pasti.
Dengan munculnya LyX yang dapat dioperasikan se-
cara intuitif, hampir semua bidang dapat meman-
faatkan KTEX sebagai alat untuk menata tampilan
buku/majalah. Sistem desktop publishing (DTP) di-
gunakan untuk mengedit teks dan gambar yang di-
masukkan pada suatu halaman penuh. Jadi, secara
prinsip hampir semua jenis word- atau document-
processor dapat dijadikan salah satu komponen ma-
sukan dari sistem DTP. Apa keunggulan LyX pada sisi
aplikasi DTP?

KTEX yang bekerja di balik aplikasi LyX meru-
pakan text-processor yang memiliki banyak keunggu-
lan dibandingkan word-processor, di antaranya adalah
konsistensi, referensi-silang dan penempatan gam-
bar/tabel secara otomatis, serta penyusunan pustaka
yang konsisten. Konsistensi tata letak ini disebabkan
karena semua komponen tata letak dikontrol oleh
suatu makro atau paket IXIEX. Dengan kata lain,
sekali suatu makro didefinisikan maka akan didap-
atkan tata letak yang sangat konsisten.

Keistimewaan lainnya dari program ini adalah
pengarsipan berkas dapat dilakukan dengan baik
dan rapi, karena format yang digunakan berupa for-
mat standard, yaitu ASCII atau teks datar (plain text)
yang ditambah beberapa perintah yang dikenal oleh
IyX (LyX-tag). Dengan demikian berkas LyX akan
dapat diakses kapan saja, tidak mengenal batasan



Table 1: Perangkat lunak berbasis OpenSource yang dapat digunakan untuk mengolah naskah publikasi ilmiah

| Macam analisis | Program (berlisensi GPL)

Keterangan |

fice

Pengolahan gam- | GIMP dan ImageMagik Mengolah foto dan data raster, dapat untuk mengim-
bar/citra port gambar terformat PDF atau PS.

Grafik Gnuplot, GMT dan SciDavis | Untuk membuat grafik 2 atau 3 dimensi

Paket Office OpenOffice.org dan LibreOf- | Untuk mengolah data numerik yang disusun atas

baris dan kolom, dan mengetik naskah teks (word pro-
cessor).

Menggambar 2 di-
mensi

Inkscape, Xfig

Alat gambar berbasis vektor, seperti CorelDraw di Mi-
crosoft Windows

Dokumentasi LyX, MikTEX, ProTgXt,

MACTgX, dan TRXMACS

Pengolahan naskah (document processor) berbasis TEX

waktu. Hal ini dapat dibandingkan dengan berkas-
berkas yang dihasilkan oleh program pengolah kata
lainnya yang terformat biner, seperti WordPerfect,
WordPro, MicrosoftWord, dll. Anda akan menda-
patkan kesulitan bila saat ini anda masih menyim-
pan berkas-berkas tersebut dan ingin membukanya
kembali. Belum lagi bila anda menuliskan berkas-
berkas penting anda dengan versi lama kemudian
anda membuka atau menuliskan kembali dengan
versi terbaru atau sebaliknya, anda akan mendap-
atkan tampilan yang berbeda. Bahkan kadang kala
berkas yang telah ditulis banyak data yang hilang.

4 Perbedaan LyX dan pengolah kata

Hal yang paling penting untuk diketahui pada
pemakaian perangkat lunak LyX adalah merubah
paradigma, dari paradigma “konsep mesin ketik” ke
paradigma bahasa “markup”. Berikut ini adalah sesu-
atu yang tidak akan pernah ditemukan di LyX:

e Penggaris naskah

e Pemberhentian tab
e Spasi ekstra (misalnya menekan tombol

atau dua kali atau lebih)

Pada pengolah kata, penggaris naskah, fasilitas

ekstra-spasi sangat dibutuhkan karena segala
penyusunan kata dilakukan oleh pengguna. Cara
ini sangat berbeda dengan perangkat lunak pengolah
dokumen, dimana semua susunan komponen naskah
diatur oleh perangkat lunak. Meskipun demikian,
kita juga bisa “memaksa” LyX baik untuk ekstra-spasi
ataupun dengan menambahkan makro khusus untuk
TAB |,

Berikut ini beberapa hal yang ada di LyX tapijarang
digunakan:

Kontrol indentasi

Pemutus halaman (page breaks)

Spasi baris

Spasi kosong, baik vertikal ataupun horisontal

Huruf dan ukuran huruf

e Bentuk huruf (tebal, miring, garis bawah, dll)

Meskipun ini tersedia di LyX, namun tidak harus
digunakan jika tidak diperlukan sama sekali. LyX
akan mengatur semua hal yang berhubungan dengan
type-setting, tergantung yang style digunakan. Bagian
yang berbeda pada naskah akan secara otomatis diset
dengan huruf dan ukuran huruf yang berbeda oleh
LyX. Indentasi paragraf tergantung kepada kontek;
jenis paragraf yang berbeda mempunyai indentasi
berbeda.

Selain hal di atas, LyX yang didukung oleh XTEX
dapat mengerjakan hal-hal berikut ini:

e Pemotongan kata (hyphenation) otomatis

e Segala macam daftar (isi, gambar, tabel, pustaka,
indeks)

Rumus-rumus matematika yang kompleks
Aneka macam tabel

o Referensi silang

5 Migrasi dari MicrosoftWord ke LyX

Di dunia OpenSource, terdapat perangkat lunak un-
tuk mengonversi file *.doc (versi 2003 ke bawah)
yang sudah diintegrasi di LyX, yaitu wvCleanLa-
tex. Perangkat lunak ini berfungsi untuk mengkon-
versi *.doc ke IfTgX yang dapat dibaca oleh LyX.
Jika perangkat lunak ini tidak tersedia di sistem
anda, simpan file *.doc menjadi *.txt melalui OpenOf-
fice.org Writer. OpenOffice.org menyimpan file *.txt
sangat bersih, sehingga ketika diimport dengan LyX,
proses editingnya tidak memakan waktu. Gambar
dan tabel tidak termasuk dalam teks ini, dan harus
diperlakukan berbeda ketika akan diimport dengan
LyX.

Gambar dapat disimpan dari OpenOffice.org men-
jadi file terformat gambar (sesuai gambar aslinya),
kecuali bagan alir yang dibuat oleh Microsoft-
Word. Gambar yang terakhir ini harus diperlakukan
‘khusus’, misalnya export ke PDE lalu file PDF
dibaca dengan GIMP, dicrop dan disimpan dalam
format gambar. Tabel agak spesial daripada gam-
bar, karena LyX dapat membuat tabel sendiri. Kalau
tabel tidak dibuat khusus, misalnya rata desimal,
dll., maka tabel dapat dibuat dengan menggunakan
perangkat lunak eksternal (misal OpenOffice.org)
dan diimport sebagai gambar dalam format PS atau
PDE



6 Menu pada LyX

Seperti telah dijelaskan pada bab sebelumnya, bahwa
LyX bukan suatu perangkat lunak WYSIWYG, na-
mun merupakan sebuah perangkat lunak WYSI-
WYM. Dengan demikian tampilan di layar monitor
akan berbeda dengan tampilan yang dicetak. Un-
tuk dapat menggunakan LyX dengan baik diperlukan
pengenalan tentang menu-menu pada LyX tersebut.

Secara prinsip, menu L[yX mendekati kesamaan
dengan menu pada perangkat lunak pengolah kata
berbasis grafis yang lain. Namun menu LyX tidak
sekompleks perangkat pengolah kata yang lain,
karena LyX bukan pengolah kata biasa melainkan
pengolah dokumen. Fasilitas penyuntingan kata
demi kata tidak tersedia secara lengkap di LyX.

6.1 Menu layar pembuka
6.1.1 Menjalankan LyX.

LyX dapat dijalankan baik melalui konsul atau ter-
minal X dengan memanggil lyx lalu tekan

maupun melalui menu pemilihan program pada
desktop, misalnya Start > Office > Wordprocessor > LyX
(tergantung kepada Window manajer yang digu-
nakan). Setelah pemanggilan ini akan muncul tampi-
lan layar pembuka LyX seperti pada Gambar 2.

Pada bagian atas Gambar 2 dapat dilihat menu-
menu dari layar pembuka LyX, yang terdiri dari File,
Edit, Insert, Layout, View, Navigate, Documents, dan
Help. Namun baik menu pull-down maupun icon
tidak semuanya aktif, karena belum ada naskah yang
disunting. Huruf yang bergaris bawah pada menu
merupakan shortcut yang dapat digunakan bersama-

sama tombol , misalnya untuk membuka
menu-menu yang berhubungan dengan berkas. Atau
penggunaan shortcut yang lebih cepat dapat juga di-

lakukan misalnya dengan kombinasi tombol

seperti untuk membuat berkas baru.

Dengan mengklik pull-down menu File atau
akan muncul beberapa pilihan aktif dari semua menu
yang berhubungan dengan perintah File, seperti New,
New from Template, Open, Import, Exit dan Daftar
berkas di direktori yang aktif (lihat Gambar 3). Dari
kelima menu tersebut yang berbeda hanya satu, yaitu
pada menu Import yang mempunyai tanda mata
panah ke kanan, yang berarti masih ada submenu
berikutnya, yaitu: ASCII text as lines..., ASCII text as
paragraph..., IATEX..., LinuxDoc..., Noweb..., dan Word...
(Lihat Gambar 3).

6.1.2 Cara membuka berkas

Jika berkas LyX sudah pernah ada dan akan dis-
unting, maka LyX dapat langsung membuka berkas
tersebut tanpa melalui langkah-langkah di atas.
Naskah LyX (misal buku-lyx.lyx) dapat dibuka
melalui terminal X dengan perintah sebagai berikut:

$ lyx buku-lyx.lyx

Selain dengan cara di atas, membuka berkas lama
LyX dapat juga dilakukan melalui menu File>Open...

sehingga akan muncul kotak dialog seperti tampak
pada Gambar 5.

6.1.3 Mengatur preferensi

Secara default tampilan LyX mungkin tidak sesuai
dengan layar yang digunakan, misalnya resolusi la-
yar tidak cocok dengan besar huruf yang ditampilkan
di layar sehingga huruf menjadi terlalu kecil atau ter-
lalu besar. Untuk mengeset tampilan atau keluaran
LyX secara global dapat dilakukan pada menu Edit>
Preference.... Menu ini terdiri dari beberapa sub-
menu, seperti Look and feel, Language settings, Out-
puts, Paths, Converters, dan File formats.

Preferensi Look and feel terdiri atas pengaturan
tatap muka (interface), huruf layar, warna, grafik, dan
keyboard (lihat Gambar 6). Hal yang perlu diset pada
pengaturan ini adalah huruf layar, yaitu huruf yang
tampak pada daerah penyuntingan LyX. Huruf ini
tidak sama dengan huruf naskah ketika dicetak atau
dipreview. Penentuan huruf ini hanya untuk kenya-
manan ketika menyunting naskah. Pada submenu ini
juga harus ditentukan resolusi layar (Screen DPI) dan
persentase perbesarannya (Zoom %).

Preferensi Language Settings terdiri atas Language
dan Spelichecker. Bahasa secara default ketika LyX
diinstal adalah bahasa, sehingga jika ingin mengetik
dalam bahasa Indonesia misalnya, kolom Default lan-
guage harus diganti dengan Indonesia. Kolom lain
secara otomatis diisi oleh LyX (lihat Gambar 7).

6.1.4 Petunjuk penggunaan

Selain buku ini, LyX juga menyediakan petunjuk
penggunaan yang dapat ditampilkan melalui menu
Help (lihat Gambar 8). Pada menu ini dapat dipilih
Introduction, yang berisi pengantar tentang perangkat
lunak LyX. Tutorial berisi uraian secara singkat
bagaimana menggunakan perangkat lunak ini. User’s
Guide berisi uraian lengkap bagaimana menggu-
nakan LyX. Extended Features berisi uraian menge-
nai tambahan menggunakan LyX untuk pengguna
yang sudah mahir memakai LyX. Customization berisi
cara-cara untuk memodifikasi tampilan LyX, baik ba-
hasa menu maupun keyboard binding. FAQ (Fre-
quently Asked Questions) berisi beberapa pertanyaan
umum yang sering diajukan oleh pengguna beserta
jawabannya. Table of Contents berisi daftar isi dari
Help yang disediakan oleh LyX. KIgX Configuration
berisi inventarisasi dari konfigurasi IXTEX yang terin-
stal, seperti paket apasaja yang sudah dikenal oleh
LyX.

6.2 Menu layar penyunting

Menu layar penyunting mulai aktif ketika ada naskah
yang sedang dibuka oleh LyX. Berbeda dengan
menu pada layar pembuka, yang sebagian besar baik
pulldown-menu maupun ikonnya tidak aktif, menu
pada layar penyunting sebagian besar menu dan ikon
aktif. Hanya ada beberapa menu dan ikon yang tidak
aktif, seperti potong (cut), salin (copy) dan tumpuk
(paste). Layar penyunting dapat dibagi menjadi lima
bagian:
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Figure 2: Tampilan menu pembuka LyX
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Figure 3: Tampilan menu membuat file baru di LyX



Figure 4: Tampilan menu Import pada LyX.

‘Select document to open

Address Labaratary = Picture1 Teachings
5 AUN-SEED.Net £ Lectures £ PortraitPhotos
B Letters £5 PostScript Templates
£ Logos 5 Presentations &5 Textdocuments
! £ LyxaJournal 551 Projects £ TopSecret
5 Department £ LyXdocuments 53 Proposal Traditian
5 Ekskursi £5 Memberships &5 Publications &5 Travelling
5 Eksplorium £ MinePlanning £ Questionnaire  £5 TugasAkhir
£5 Equipments £ Mischung £ Rapat Unclassed
| &= Graphics B MyCareer 55 RechenZentrum £2 Wallpapers

£5 Healths 5 MyFamily £5 References £ Warkshop

55 Hinduism £ Others 55 Research |2/ Endapan Mineral.lyx
5 HTMLdocumants 55 PDF-files £3 Resume-Dosen

& ljazah &5 Peraturan 5 Reviews

=5 Images £ Perpustakaan £ Scanimagss

£ Invoice £ PHK-A3Z 5 SkripsiYanti

5 KKN-UGM £ PHIK 51 Spreadshests

Figure 5: Dialog boks dari menu File>Open
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Figure 6: Dialog boks dari menu preferensi layar

LyX: Preferences

User Interface
Screen Fonts
Colors
Display

~ Editing

Languag
Spellichecker
>-Output

>~ File Handling

Figure 7: Dialog boks dari menu preferensi bahasa
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Feynman-diagram Manual
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Figure 8: Beberapa pilihan alat-alat bantu pada menu Help

1. Pulldown-menu terletak di bagian paling atas

2. Ikon terletak di bawah pulldown-menu

3. Ruang kerja (workspace) merupakan daerah tem-
pat mengetikkan apa saja dari naskah yang akan
dibuat

4. Ruang untuk memasukkan perintah pendek

pada perintah misalnya accent-grave

a untuk menuliskan huruf “a”.

5. Komentar kerja LyX termasuk deskripsi font
pada lokasi pointer.

6.2.1 Tulis, simpan, tampilkan dan cetak

Empat hal yang secara berulang-ulang akan di-
gunakan pada saat menyunting naskah dengan
LyX. Untuk mencoba menggunakan perangkat lu-
nak ini, cobalah membuat suatu berkas, misal-
nya coba.lyx dengan perintah File>New... maka
akan muncul layar kosong dengan nama header
LyX:.../LyXdocuments/newfilel.lyx. Hal ini berarti
berkas baru LyX sudah siap untuk diisi.

Sebagai contoh, ketikanlah isi tulisan berikut ini
pada naskah kosong tersebut lalu simpanlah dengan

perintah File>Save atau atau File>Save As...

atau | Ctrl-S | dengan nama coba. LyX secara otomatis
akan menambahkan ekstensi .1lyx dari nama terse-
but.

Sekarang saya sudah  bisa  mengetikkan
berkas.lyx dengan bantuan dari buku ini.

Melihat tampilannya yang sederhana den-
gan sedikit ikon, saya menjadi ragu untuk
mencobanya. Namun berkat “komporan”
teman-teman yang sudah lebih dulu memakai
LyX akhirnya saya menjadi sulit melupakan
LyX. LyX begitu memukau saya akan hasil
keluarannya baik dalam  format elektronik
(PostScript dan PDF) maupun hasil cetaknya.

Berikan juga tambahan beberapa teks seperti mis-
alnya “Belajar LyX lima menit....” lalu klik tanda
panah ke bawah pada kolom “Standard” (kotak pal-
ing kiri kumpulan ikon) dan pilih “Title”. Jangan
lupa mengetikkan nama anda sebagai penulis (Au-
thor) dan pilih “Author” pada kolom “Standard”.
Artikel yang anda tulis sudah cukup lengkap, lalu
klik View > Postscript untuk melihat tampilannya den-
gan GSView/gv, atau View > PDF untuk melihat tampi-
lannya dengan Acrobat Reader.

6.2.2 Spasi, TAB dan Enter

Seperti telah diuraikan pada subbab 4 bahwa LyX
tidak mengenal Spasi dan Enter lebih serta TAB.
Meskipun kita menekan tombol Spasi berulang-
ulang, spasi akan tetap satu karakter. Ini merupakan
standar penulisan tulisan ilmiah yang padat. Begitu
juga tombol Enter, LyX tidak mengenal spasi antar
paragraf lebih dari satu Enter.

Namun demikian, LyX memberikan fasilitas untuk
menambah spasi horisontal maupun vertikal suatu



naskah yang akan kita sebut sebagai spasi tidak nor-
mal. Spasi horisontal tidak normal dapat dilakukan

dengan menekan tombol dan bersama-

sama. Penambahan spasi vertikal tidak normal dapat
dilakukan dengan dua cara, yaitu dengan perintah

+ yang akan muncul seperti pada Gam-

bar 9 atau dengan menambahkan spasi antar para-
graf melalui perintah Layout> Paragraph...>Spacing
yang akan muncul seperti pada Gambar 10.

wwwes — menambah spasi horisontal

Perintah di atas untuk menambah spasi vertikal dengan

kombinasi tombol ‘Ctl’1+Entel‘ atau dengan menambahkan

jarak antar paragraf, seperti berikut ini:

Vertical Space (1.5cm, protected)

Jarak antara paragraf di atas dan paragraf ini. Atau bisa juga
dengan menambahkan perintah dalam ERT \wspace*{1.5cm}.

Figure 9: Cara menambahkan spasi tidak normal
pada naska LyX

v gy Ly¥: vepace O & g X
Spacing: | Custom v
Valus: (15 tm i
Protect. |+|

|+/| Synchronize Dialog = Imrmediate Apply

| Bsstare. | | Newinset | [ BK | | Apply || Close |

Figure 10: Tampilan layout paragraf untuk menam-
bahkan spasi antar paragraf

6.2.3 Menyunting naskah

Menyunting naskah tidak jauh berbeda dengan pen-
golah kata yang lain. Tombol-tombol standard yang
biasanya digunakan untuk menyunting naskah dapat

digunakan untuk LyX, seperti untuk menyalin
teks dan untuk menempelkan salinan kem-
bali. Begitu juga dengan perintah [Ctrl-x] dan [Ctrl-z]
yang masing-masing untuk menghapus teks dan
membatalkan perintah.

Selain perintah-perintah di atas, perintah standard
penyuntingan pengolah kata juga bisa digunakan,
seperti perintah-perintah berikut ini:

o [ Home] atau [ End] untuk meletakkan pointer
pada awal atau akhir dari baris kalimat yang di-
tunjuk oleh pointer.

° atau untuk meletakkan

pointer pada awal atau akhir naskah.

° atau untuk memindahkan

pointer pada huruf awal atau akhir dari suatu
kata terdekat.

° [Ctrl-ﬂ atau (Ctrl-i] untuk memindahkan pointer
antar alinea.

o | Ctrl-Delete | untuk menghapus kata yang ter-

letak di belakang pointer.

e | Ctrl-Backspace | untuk menghapus kata yang
terletak di depan pointer.

Selain perintah-perintah di atas, juga tersedia ikon-
ikon sebagai fasilitas penyuntingan pada perangkat
lunak LyX yang dapat dibagi menjadi tujuh bagian:

Standard W .
o merupakan ikon untuk

memilih lingkungan paragraf dari naskah yang
sedang diedit.

=1 0= =|
L = & merupakan ikon input-output

yang terdiri atas membuka, menyimpan dan
mencetak naskah.

% i
= ERQ merupakan ikon-ikon un-
tuk mengedit naskah.  Berturut-turut dari
kiri ke kanan adalah undo/redo, memo-
tong/menghapus, menyalin, menumpuk teks,
pencarian dan penggantian, navigasi balik.

A & B ikon ini digunakan untuk menset
huruf, dari kiri ke kanan berturut-turut adalah
huruf miring (emph) atau , NOUN atau
SMALLCAPS, dan font yang definisikan peng-
guna. Membuat huruf tercetak tebal dan
bergaris bawah dapat dilakukan dengan perin-

tah [ Ctrl-b] dan [ Ctrl-u ]

o Z L ikon ini berguna untuk menyisip-
kan gambar dan tabel non-float pada naskah.

Voo 70

R merupakan ikon untuk menyisip-
kan perintah ERT atau TgX style dan makro per-
samaan matematika.

7 Menggunakan style

Berbeda dengan pengolah kata yang biasanya lang-
sung menulis tanpa memikirkan bentuk tulisan yang
bagaimana yang akan dibuat, pada pengolah doku-
men langkah awal adalah menentukan jenis naskah
yang akan dibuat. Penentuan jenis naskah (document
class) akan mengarahkan kepada lingkungan para-
graf yang akan muncul. Sebagai contoh pada je-
nis naskah buku (Book) akan muncul lingkungan bab
(Chapter), sedangkan pada jenis naskah article (ar-
tikel) lingkungan ini tidak akan muncul. Penentuan
jenis naskah ini merupakan pemformatan dasar dari
program LyX.

Pemformatan ini dapat dilakukan dengan mengk-
lik perintah Layout>Document...  sehingga akan



munchl tampilan kotak dialog seperti pada Gam-
bar 11. Pada kotak jendela tersebut terdiri atas be-
berapa bagian, seperti Layout, Paper, Margins, Lan-
guage, Bullets, Numbering, Bibliography, Packages,
dan Preamble.

LyX dirancang sedemikian rupa agar waktu untuk
mengatur atau memformat tata-letak naskah dapat
dilakukan seminimal mungkin. Sehingga pekerjaan
hanya difokuskan pada pengetikan isi naskah. Oleh
karena itu dibutuhkan beberapa hal dalam kegiatan
mengatur tata-letak komponen naskah:

e Kelas naskah
e Lingkungan paragraf
e Jenis huruf

Sebuah Klas naskah menetapkan format lain yang
tersedia, tetapi untuk sebagian besar anda tidak
membutuhkan keistimewaan tersebut. Standard jenis
Klas naskah adalah Article yang sangat sesuai dengan
sebagian besar jenis naskah yang anda tulis, tetapi
anda dapat juga mencoba bereksperimen dengan je-
nis Klas naskah lainnya.

Untuk mengubah setiap jenis Klas naskah dapat
anda lakukan dengan mengklik menu Documentr
Settings...> Document Class yang akan terlihat seperti
pada Gambar 11. Setelah itu pilih jenis Klas yang di-
inginkan sesuai dengan keperluan. Hingga pada pro-
gram LyX versi 2.0.1 secara lengkap jenis-jenis Klas
naskah yang terdapat adalah sebagai berikut:

Curriculum Vitae

DocBook article (SGML)
DocBook book (SGML)
DocBook chapter (SGML)
DocBook section (SGML)
SGML (Linuxdoc article)
SGML (Linuxdoc manpage)
Article (AMS)

Article (AMS, sequential numbering)
Article (AMS, unnumbered)
Article (Hebrew)

Article (REVTEX 4)

Article (REVTEX)

Article (Springer- eJour2)
Article (Koma-Script)

Book

Book (AMS)

Book (Koma-Script)
Broadway

Hollywood

Letter

Letter (Hebrew)

Letter (g-brief)

Letter (g-brief, german)
Letter (german)

Letter (italian)

Letter (koma-script)
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Report

Report (koma-script)
Seminar

Slide (default)

8 Gambar dan tabel

8.1 Format gambar

Arikel atau buku tidak akan lengkap tanpa ada gam-
bar baik berupa grafik maupun gambar raster di
dalamnya. Dalam grafik dikenal ada dua macam for-
mat gambar, yaitu gambar vektor dan gambar raster.
Gambar vektor sangat mudah disisipkan pada IXTEX
atau LyX, karena hampir semua program penghasil
grafik vektor menghasilkan format grafik standard
postscript atau EPS (Encapsulated PostScript). Berbeda
dengan gambar vektor, gambar raster sangat mem-
punyai jenis yang sangat beragam, misalnya bmp
(Windows bitmap), tiff, jpeg, gif, png, targa, dlIL
Apakah LyX bisa mengimport jenis gambar ini?

Sebelum menjawab pertanyaan ini, kita bisa li-
hat terlebih dahulu jenis format data apa yang
akan dikirim ke devais keluaran selain devais be-
bas (dvi, device independence), yaitu printer atau la-
yar. Ada dua macam format keluaran yang bi-
asa dipakai untuk hal ini, yaitu postscript dan pdf
(portable data format). Dalam penyisipan gambar
raster pada berkas IXTgX kedua tipe format keluaran
ini memerlukan perlakuan masing-masing, karena
kedua format ini bukan standard keluaran KIEX
(keluaran standard I£TgX adalah dvi). Untuk meng-
hasilkan berkas postscript IXIEX membutuhkan pro-
gram bantu lain seperti dvips, sedangkan untuk
menghasilkan berkas pdf program ini membutuhkan
program bantu ps2pdf atau pdflatex, tex2pdf, pdftex.

Pada keluaran postscript atau pdf melalui program
ps2pdf, gambar raster yang bisa disisipkan langsung
adalah berformat eps. Namun bukan berarti format
selain ini tidak bisa disisipkan pada berkas LyX. Pada
prinsipnya berkas gambar jenis apa saja dapat dis-
isipkan dalam berkas LyX, selama program konversi
berkas tersebut ke dalam berkas eps tersedia dan da-
pat diakses oleh program TgX.

Berbeda dengan keluaran postscript, pada kelu-
aran pdf melalui program pdftex, pdflatex, tex2pdf
belum dikenal grafik berformat eps. Format gam-
bar yang dikenal oleh program pdftex misalnya pdf,
png, dan jpeg. Selain format ini harus dikonversi
ke salah satu dari tiga jenis format ini. Dalam
lingkungan Linux tidak terlalu sulit. Tersedia banyak
program untuk mengkonversi ke salah satu berkas
ini, misalnya convert (ImageMagick), epstopdf,
pnmtopng.

Dalam pembuatan naskah, gambar yang paling
penting adalah resolusinya. Resolusi yang terlalu
besar menyebabkan berkas menjadi gemuk dan be-
rat jika diakses dengan internet, sedangkan resolusi
yang kecil menyebabkan gambar menjadi kabur atau
buram. Berapakah resolusi yang tepat? Tergan-
tung format gambarnya, apakah raster atau “raster-
ized” vektor (sama-sama raster). Resolusi yang pal-
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Figure 11: Kotak jendela tata-letak naskah

ing aman adalah 450 dpi pada semua gambar raster.
Tidak ada resolusi untuk gambar terformat vektor.

8.2 Membuat tabel

Tabel merupakan salah satu cara untuk menampilkan
ringkasan data dari suatu teks. Satu buah tabel da-
pat mewakili ribuan kata-kata. Tabel dapat terdiri
dari teks atau angka-angka. Tabel teks biasanya digu-
nakan untuk menampilkan deskripsi suatu hal secara
tabelaris. Ada beberapa cara yang dapat digunakan
untuk menampilkan tabel teks secara baik dengan
menggunakan LyX.

8.2.1 Tabel pendek/sederhana

Yang dimaksud dengan tabel pendek adalah tabel
yang panjangnya tidak melebihi margin kertas
(diukur dari caption sampai catatankaki tabel, lihat
contoh Tabel 2). Tabel jenis ini dapat dibuat mengam-
bang dalam teks atau statis. Mengambang artinya
posisi akhir tabel akan disesuaikan tempatnya oleh
KEIEX. Untuk memudahkan layout sebaiknya pakai
tabel jenis mengambang (floating table). Perintah
untuk membuat tabel mengambang adalah Insert>
Float> Table Float. Dari perintah ini akan muncul jen-
dela float seperti berikut ini:

Isilah judul tabel (caption) terlebih dahulu lalu
tekan Enter. Untuk membuat tabel dapat dilakukan
dengan prosedur:

e Letakkan pointer persis di bawah judul tabel (di
dalam jendela float)

e Lakukan perintah Insertr> Tabel

e Isi berapa jumlah baris dan kolom yang akan
dibuat, misalnya 4 x5 (lihat jendela berikut)

e Isikan tiap sel tabel dengan data yang di-
inginkan.

8.2.2 Mengatur tampilan tabel

Secara default, tabel yang didefinisikan dengan LyX
pada menu insert-tabel akan meletakkan komponen
penyusun tabel pada posisi rata tengah. Untuk
merubah layout ini dapat dilakukan dengan perintah
berikut:

e Letakkan pointer pada salah satu sel tabel, lalu
klik Layout> Table
e Klik bagian Column/Row, dan pilihlah apakah
komponen tabel akan dibuat rata kiri, tengah
atau kanan.
e Garis pembatas antar sel juga dapat didefin-
isikan di bagian ini.
Sering kali antara judul kolom dan bagian lain dari
tabel mempunya layout yang berbeda, misalnya
pada judul kolom didefinisikan rata tengah, sedan-
gkan bagian lain rata kiri (seperti contoh di atas).
Tampilan ini dapat dilakukan dengan mendefin-
isikan sel sebagai multicol.

9 Persamaan matematika

9.1 Satuan yang tersedia

Satuan atau besaran pada naskah LyX dapat dipilih
sesuai keinginan dan jumlahnya ada sekitar 17 sat-
uan, misalnya dapat dilihat pada Tabel 3. Tidak dis-
arankan menggunakan satuan standard pada pengat-
uran naskah, seperti mm, cm, dan in. Gunakan sat-
uan % atau lebar atau tinggi karakter (seperti lebar
huruf M (em), atau tinggi huruf “x” (ex)), sehingga
ketika huruf pada naskah dibesarkan atau dikecilkan
secara serentak, proporsi jarak akan sesuai dengan
besaran huruf, tidak konstan kalau menggunakan
satuan standard. Jarak antar kolom ini menggunakan
besaran em, i.e., 1.5em. Di dunia pengolah kata tidak
dikenal satuan ini...;).



Table 2: Contoh tabel sederhana di LyX

Nama |

Materi yang disajikan |

Dr. Abe Susanto, M.Sc.

Tip dan trik menginstal dan menggunakan LyX

Dr. I Made Wiryana, MSc.

Tip dan trik sistem sekuritas dengan Linux

Dr. I Wayan Warmada

Tip dan trik mengolah grafik di Linux

| No. |
1.
2
3
4

dan lain-lain

Table 3: Satuan yang tersedia

| Satuan | Nama / Deskripsi |

mm Millimeter

cm Centimeter

in Inch (1in = 2,54 cm)

pt Point (72.27 pt = 1in)

pc Pica (1 pc =12 pt)

sp scaled point (65536 sp = 1 pt)

bp big point (72bp = 1in)

dd Didot (1dd ~ 0.376 mm)

cc Cicero (1cc=12dd)

ex Height of letter “x” in the current font
em width of letter “M” in the current font
mu math unit (1 mu = 1/18em)

%o Text Width %

% Column Width %

9.2 Menulis persamaan

Menulis persamaan di LyX jauh lebih mudah diband-
ingkan dengan menggunakan Equation Editor di Mi-
crosoftWord. Selain dengan menu box yang tersedia
di jendela LyX, persamaan dapat juga dibuat dengan
perintah IATEX, misalnya untuk menulis akar kuadrat
bisa langsung diketik \sqrt pada modus matem-
atika. Penggunaan perintah short-key bisa juga di-

lakukan, seperti tombol untuk menampilkan
modus matematika. Tombol | Shift+" | untuk membuat

superscript dan | Shift-_ | untuk subscript.

Macam-macam ukuran kurung besar (bracket), lihat
Persamaan 1. Persamaan di atasnya tidak menggu-
nakan label, sehingga tidak bisa diacu dalam teks.

n

1

oiiy = In
ijt n—1

r | RER;i mr

(exp < [{ In(3x) }? sin(x)]A>> " (1)

10 Bibliografi

Penanganan bibliografi dapat dilakukan dengan
database, yang disebut BibTgX. Semua bibliografi
dimasukkan ke dalam satu file yang terformat bib-
tex (*.bib). Untuk memasukkan database ini bisa
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dilakukan dengan beberapa perangkat lunak Open-
Source, seperti JabRef (semua platform OS), pybli-
ographer (Linux), bibdesk (MacOS X), atau manual
dengan text-editor. Contoh format bibTEX sebagai
berikut (jika tidak punya perangkat lunak di atas):

©@Book{kip01,
Author = {Kipplan, H.},
Title = {\textit{Handbook of {P}rint
{M}edia: {T}echnologies and
{P}roduction {M}ethods}},
Publisher = {Springer-Verlag},
Address = {Berlinm},
Note = {1207p.},
year = 2001
}
@Article{war03b,
Author = {Warmada, I W.},
Title = {\IyX{} sebagai aplikasi
desktop publisher},
Journal = {InfolLinux},
Volume = {09/2003},
Pages = {76-78},
year = 2003
}
Rangkuman
penerbitan terdiri atas
empat kompo- nen utama, yaitu
tipogratfi, gambar, tabel dan persamaan

matematika. Salah satu dari komponen ini tidak
dilakukan dengan serius akan menghasilkan lay-
out yang jelek, misalnya gambar buram, garis pada
gambar vektor patah-patah (apalagi jika diperbe-
sar), persamaan tidak enak dibaca. LyX dapat
digunakan untuk bermacam-macam keper-
luan penulisan karya tulis ilmiah mulai
dari artikel, laporan penelitian, skripsi,
thesis master, dan disertasi. LyX
juga dapat digunakan untuk
membuat tulisan roman-
tis dalam bentuk
seperti ini.

Q



<
tulisan
ini dibuat
dengan
perangkat lunak
LyX dan IXTEX 2¢. Gam-
bar di-grab dan diedit den-
gan perangkat lunak GIMP
menggunakan resolusi layar, 96 dpi.
Bibliografi menggunakan bibTgX dan
pybliographer. Style bibliografi menggu-
nakan style artikel Elsevier dengan model Har-
vard. Paket tambahan yang digunakan
pada artikel ini terdiri atas: abstract,
cuted, flushend, titlesec,
mathpazo, fancybox, shapepar,
color. Semua paket ini
merupakan paket
standard yang
sudah terse-
dia pada
IATEX.
<
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